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1. Intfroduction

This document provides step by step instructions to facilitate the setup and general use of customized
DND Template and Content Library for Revit 2020. The template and support content were developed to
enable the creation of Revit projects and data in accordance with the DND CAD/BIM Standard 2.3. They
are intended to be used by internal stakeholders and consultants working on DND projects.

This guide assumes the user is already familiar with basic Revit functionality and features.

1.1

New and Changed Features

Major updates and changes from previous DND Revit templates include:

Lineweights, Linestyles, and Object styles from the 2.3 CAD/BIM Standards have been added.
Families use Object Style Subcategories as per Annex A Layers of the 2.3 CAD/BIM Standards.
Generic Annotations and Tags are as per Annex B Symbols of the 2.3 CAD/BIM Standards.
DWG Export settings have been updated.

Titleblock and Cover Sheet ISO B1 have been added.

2. Acronyms

AEC

Architectural, Engineering and Construction

BIM Building Information Modelling

CAD Computer-Aided Design

DAES Directorate of Architecture and Engineering Services
DND Department of National Defence
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3. Adding the DND Toolkit to Revit

3.1 Downloading the DND CAD/BIM 2.3 Revit Template & Content

The DND CAD/BIM Standard 2.3 Revit Template and Content are available as individual downloadable
“read-only” zipped folders:

e DND Revit Template 2020 (Required Download)

Revit Family Container 2020

e Architectural General Annotations and Tags (Required Download)
e Civil Annotations and Tags

e Fire Annotations and Tags

e Hazardous Materials Annotations and Tags
e |SO Annotations and Tags

e Mechanical Annotations and Tags

e Planimetry Annotations and Tags

e Siting Annotations and Tags

e Structural Annotations and Tags

e Telecommunications Annotations and Tags

To install the most current DND BIM Toolkit into Revit, download the latest version from either of the
following locations:

= DND Digital Built Resource Centre (Public website hosted by DCC. User registration required):
https://cafnet.dcc-cdc.gc.ca/cad_bim_gis/access-eng.htm

= Digital Built DND (DND internal users only):
https://collaboration-admie.forces.mil.ca/sites/RPSCO/DB-DND/SiteAssets/DocumentLibrary.aspx

Once downloaded, the zip files containing the DND Revit Template 2020, Architectural General
Annotations and Tags, and any others you have chosen will appear in your Downloads folder or on the
desktop depending on your download options.

3.2 Setting up the Revit Template and Content Folder

After downloading both the DND Revit Template 2020 and Architectural General Annotations and Tags
files, extract the contents and set up the environment.

1. Create afolderin the C:\ Drive called DND_BIM_Toolkit.
2. Locate the DND_RTE_2020.zip and DND_Architectural-General_Anno-Tags.zip files.

3. Right-click each file and select Properties from the drop-down menu.
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4. Under the General tab on the Properties dialog, select Unblock

Open
Open in new window
i

Extract Al

»Zip General Securty Detais Previous Versions

CRCSHA &

Pin to Start i ‘DND_RTE_?OZU 2p

Type of file:  Compressed (zipped) Folder (zip)

& Share

Open with Opens wth: Ty Windows Explorer Change.

Give access to

Restore previous versions Location

Sendto Size:

Cut Size on disk:

Copy

Create shortcut Created

Del

= Modfied
Rename
Properties Accessed

(o]

computer and might be blocked
help protect this computer.

OK Cancel

Atibutes:  [JReadonly [ Hidden Advanced...

Open I

Open in new window I

Extract All.. General Securty Detals Previous Versions

7-Zip :

CRCSHA i DND_Architectural-General_Anno-Tags zip
Pin to Start . :

Typeof fle:  Compressed (zipped) Folder (.zip)

12 Share Openswih: [y Windows Explorer Change...
Open with
Give access to Location:
Restore previous versions rem
Sendto
Size on disk
Cut
C
opy Created:
Create shortcut
Delete Modd
Rename Accessed
Properties
Atrbutes:  [JReadonly [] Hidden Advanced

computer and might be bio:
help protect this computer.

OK Cancel

This action ensures all files contained in the .zip file are unblocked.

Note: The Unblock option may not be available depending on the security settings for your workstation.

5. Click OK

6. First installation Extract the files and folders from the DND_RTE_2020.zip and DND_Architectural-
General_Anno-Tags.zip files to the C:\DND_BIM_Toolkit Folder.

OR

To update the toolkit first delete previous version on your C:\ Drive to avoid duplicate files.

Extract

share View Compressed Folder Tools

¢ Extract Compressed (Zipped) Folders

Select a Destination and Extract Files

Files will be extracted to this folder:

[ C:\DND_BIM_Toolkit

[] Show extracted files when complete

7. Click Extract.

8. Repeat the steps above for all other content downloaded as required.

Note: See section 4.1.1 Families Folders Structures of guide for folder structure.

DND BIM Template and Content User Guide

Page 3



3.3 Adding the Template to Revit
1. Open Revit 2020.

2. Click the Home button on the starting screen.

®

MODELS
& Open..
[ New..
FAMILIES

& Open..

[ New..

3. Click the File Menu and select Options to open the Options menu.
RECGHG G- 2-F0A G-/

Architecture ~ Structure  Steel  Systems  Insert

Annotate

o'_j Recent Documents

Dy >,

| Options |

| Exit Revit |
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4. Navigate to File Locations

Options
General Project templates: The templates display in a list when you create a new project.
User Interface
1E Name Path
Graphics E Construction Temp..] C:\ProgramData\Autodesk\RVT 2020\ Temp...
Hardware ¢ Architectural Temp... C:\ProgramData\Autodesk\RVT 2020\ Temp...
) - + Structural Template  C:\ProgramData\Autodesk\RVT 2020\Temp...
Mechanical Templ... | C:\ProgramData\Autodesk\RVT 2020\Temp...
r =
Rendering
Check Spelling
SteeringWheels
) Default path for user files:
ViewCube |C:\Llsers ‘ FE—
Macros Default path for family template fles:
| C:\ProgramData\Autodesk\RVT 2020\Family Templates\English ‘ I Browse... J
Root path for point douds:
|C:\Users ‘ | Browse... ‘

Systems analysis workflows:

1E Name

Path

Annual Building En.... C:\Program Files\NREL\OpenStudio CLI For...

¥ HVAC Systems Loa... . C:\Program Files\NREL\OpenStudio CLI For...

¥+

—

o | omat [ e ]

5. Click the Add Value [*] icon and navigate to the folder where the DND Toolkit was unzipped.

v 4 Bl X B] vews ~

6. Select the DND RTE 2020.rte template file.
R Brow r Template File
Lookin: | DND_BIM Toolit

Name E Date modified Type Size
Architectural and General 6/4/2021 10:37 AM File folder
Civil 6/7/2021 1:18PM File folder
Electrical 6/7/2021 1:18 PM File folder
Fire 6/7/2021 1:19PM File folder
Hazardous Materials 6/7/2021 1:20 PM File folder
Mechanical 6/7/2021 1:18 PM File folder
Planimetry 6/7/2021 1:18PM File folder
Siting 6/7/2021 1:19PM File folder
Structural 6/7/2021 1:18 PM File folder
= ioaimimnitivk .

EDND RTE 2020.rte 2/18/2021 &:13 PM Autodesk Revit Te... 7444 KB ]

File name: | DND RTE 2020.rte

Files of type: |Templafte Files (*.rte)

Preview

4 | open | | concel
7. Select Open.
8. Select OK.
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3.4 Creating a new Project with the DND RTE 2020

1. On the starting screen, under Models, select New and then select the

DND RTE 2020 template file in the dropdown list.

©

MODELS
& Open.
[ [ New.. } ﬁ
FAMILIES
New Project
& Open..
[ New..

OR

On the home screen, select File > New > Project and then select the DND RTE 2020 template in the
in the dropdown list.

REHG -G -&

-Sle- oA 80 E)

Architecture  Structure  Systems Insert Annotate  Analyz

EEJ I Creates a Revit file.

[ e

|
, m Project 1
Creates aRevit projectfile. |

‘E Open
H =

»

O Family ﬁ
JI Creates a set of custom components

to use in projects. New Project

Conceptual Mass Template file

Opens a template for creating a

conceptual massing model. [ono RTE 2020 v Browse...

Title Block

Canstruction Template
E g:::;:;lelymplazum creating a Title Architectural T te
§ Structural Template te
Mechanical Te te

Annotation Symbol
J,<> Creates a tag or symbol to identify |I| Cancel

== elements in the project.

m Workflow »
“:;:1, Publish  »
@ Print »
I:a Close
Options Exit Revit
2. Click OK

3. Save As a new project.
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4. Using the Revit Family Container Library

4.1 Families

4.1.1 Families Folders Structure

The Revit family container library folder included in the toolkit folder contains Generic Annotations and
Tags organized by discipline as outlined in the DND CAB/BIM 2.3 Standards. The following outline shows

the structure of the DND BIM toolkit folders:

C:\DND_BIM_Toolkit
\ Architectural and General
\ Generic Annotations
\ Tags
\ Supporting Files
\ Electrical
\ Electrical _ General
\ Generic Annotations
\ Tags
\ Electrical _ Security & Special Systems
\ Generic Annotations
\ Tags
\ Electrical _ Schematic
\ Generic Annotations
\ Tags
\ Mechanical
\ Mechanical _ HVAC & HTCW
\ Generic Annotations
\ Tags
\ Mechanical _ Piping & Eqpt
\ Generic Annotations
\ Tags
\ Mechanical _ Riser Diagram
\ Generic Annotations
\ Tags
\ Structural
\ Generic Annotations
\ Tags
\ Telecommunications
\ Generic Annotations
\ Tags
\ Fire
\ Generic Annotations
\ Tags
\ Structural
\ Generic Annotations
\ Tags
\ Siting
\ Generic Annotations
\ Tags
\ Planimetry
\ Generic Annotations
\ Tags
\ Hazardous Materials
\ Civil
\ Generic Annotations
\ Tags
\ DND_RTE_2020.RTE
\ DND_BIM_Family_Container_2020.RVT

DND BIM Template and Content User Guide
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4.1.2 Loading Families into Project

Families can be loaded into projects by:

a) Copying and pasting from the Revit Family Container using the clipboard.

b) Clicking and dragging from the provided content folders in File Explorer.

c) Using the Load Family button on the Insert tab, open from the provided content folder.

4.1.3 Content Included in Revit Family Container

Families included in the toolkit cover all DND CAD/BIM 2.3 Standards using Generic Annotations and
Tags for Elements. They are organized by the disciplines of architecture, engineering and construction as
outlined in DND CAD/BIM 2.3 Standards. Lineweights, Linestyles and Line types specified by the 2.3

CAD/BIM Standards are included.

Below is an image of the Project Browser layout of the DND_Revit_Family_Container_2020.rvt

Project Browser - DND_BIM_Family_Container_2020.rvt

=10 Views (all)
% Floor Plans (DND Plan) \
SAMPLE_VIEW-FLOOR_PLAN

SAMPLE_VIEW-FLOOR_PLAN-CALLOUT
=) Ceiling Plans (DND RCP)
SAMPLE_VIEW-RCP

X

SAMPLE_VIEW-RCP-CALLOUT

=) Elevations (DND Elevation)
SAMPLE_VIEW-ELEVATION
SAMPLE_VIEW-ELEVATION-CALLOUT

=) Sections (DND Section)
SAMPLE_VIEW-SECTION

SAMPLE_VIEW-SECTION-CALLOUT /

rafting Views . 5) \
CIVIL - ANNEX B - GENERIC ANNOTATIONS
ELECTRICAL - ANNEX B - GENERIC ANNOTATIONS
FIRE - ANNEX B - GENERIC ANNCTATIONS

Sample Views

HAZARDOUS MATERIALS - ANNEX B - GENERIC ANNOTATIONS
MECHANICAL - ANNEX B - GENERIC ANNOTATIONS
PLANIMETRY - ANNEX B - GENERIC ANNCTATIONS

SITING - ANNEX B - GENERIC ANNCTATICNS

STRUCTURAL - ANNEX B - GENERIC ANNOTATIONS

Generic Annotations

TELECOMMUNICATIONS - ANNEX B - GENERIC ANNOTATIONS
S
=) Drafting Views (STARTUP)
STARTING VIEW
l#8= Legends
CADBIM 2.3 STANDARDS
CIVIL - ANNEX B - TAGS
ELECTRICAL - ANNEX B - TAGS
FIRE - ANNEX B - TAGS
GENERAL AND ARCHITECTURAL - ANNEX B
MECHANICAL - ANNEX B - TAGS
PLANIMETRY - ANNEX B - TAGS
SITING - ANNEX B - TAGS

TELECOMMUNICATIONS - ANNEX B - TAGS
Schedules/Quantities (all)
SHEET LIST

Starting View

Tags

STRUCTURAL - ANNEX B - TAGS

s (all)
@ 000 - COVER SHEET
100 - TITLEBLOCK

Sheet List

Sample Titleblocks

&-2] Families
@-[@] Groups
&5 Revit Links

DND BIM Template and Content User Guide
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1)

2)

3)

REeHG- =

| - Re&
u
i
e

4)
5)
6)

Sample Views These contain views as samples that contain; Grids, Levels, Section Tags,
Elevations, Callouts and Dimensions for use in drafting, as per DND CAD/BIM 2.3
Standards.

Generic Annotations These drafting views contain the Symbols from Annex B as Generic
Annotation Families.

Starting View This is the Starting View required for all DND Projects using Revit. It is
already set in both the Template and Container File. Can be set using the starting view
command under the manage tab.

82 2AA G-
e (e

CHoE= Autodesk Revit 2020.2 - DND_BIM Family. Container 2020.nvt - Drafting View: STARTING VIEW.

« 08 8 AMscdonald.. v W @) - A X

cture Steel ssing & Ste  Callaborste

(o]

Tags The Legends contain the Symbols from Annex B as Tags and/or System Families.
Sheet List Contains a sample sheet list for use with the Cover Page.
Sample Title Block Contains a Cover Sheet and Titleblock, I1SO B1.

4.1.4 Export DWG/DXF from Revit
1. When exporting DWG/DXF from Revit, select File

2. Navigate to Export and select CAD Formats from the list
3. Select the appropriate CAD file format for the project.
REeHG-»-4- @ 2-FO0A -0 -~
Architecture  Structure  Steel  Systems  Inset  Annotate  Analyze  Mas
(=) ———— B O
New » Lp CAD Formats , LEows
Q QJ Creates DWG, DXF, DGN, or SAT files. ]gT]
(- over @ ot wowrnes e oon
2 ACIS (SAT)
= P
e e
E Export NWC
'L sover ! .
=
[ . .
= = IMPOR

The Export pane for the selected file format option opens.

4. Onthe DWG Export pane, select the ellipses [ ] next to Select Export Setup to open the
Modify DWG/DXF Export Setup pane.
5. Ensure the provided DND CAD BIM 2.3 export settings are selected in the Select Export Setup

Pane.

DND BIM Template and Content User Guide Page 9



6. On the Lines tab, ensure the linetype DND_General.lin is entered correctly in the Load DGW
Linetypegfrom pathf

| WG Export

1 %
| sekteicotsenn
S o
Select Views And Sheets To Export
Preview of Floor Plan: Level 1 Export; S ha
9 nh
Include | Type I Name. ‘ — S S - S - — — —
B |Escmmiet Modify DWG/DXF Export Setup 7 X
B Select Export Setup
Layers] Patterns Text &Fonts Colors Solds  Units & Coordnates General
BRoom 1 l
o a —_ Setlinetype scale: Paperspace (PSLTSCALE = 1) ~
Load DWG inetypes from: [ C:\DND_BIM \DHD_General \n‘]‘. Reset Al
Map Revit ine patterns to Inetypes in DWG:
Line Patters in Revit Linetypes in DG
a SoTd
DIND_CENTER_DASH [DND_CENTER_DASH
DND_CENTER_DOT DND_CENTER_DOT
DND_DASHED_LONG IDND_DASHED_LONG
— T e DND_DASHED_MED DND_DASHED_MED
DIND_DASHED_SHORT DND_DASHED_SHORT
OND_DOT DND_0OT
[DND_PHANTOM DND_PHANTOM

8. Select the sheets to export.
9. Click Next

Select Export Setuy
lDI\DCADBIMZ.B V]

Select Views And Sheets To Export

Preview of Drafting View: STARTING VIEW Export: <aurrent view/sheet only>

oD

Include | Type | Name
et of Canacs
ament a1 Canada
Natonal Deence =
Déterae natianaie

Drafting View: STARTING VIEW

Revit Version

Revt Archiecture 2018
TEPLATE 4% 5038 BEUSIRE 4231

Save Set & Close Cancel

When saving the selected sheets, ensure that Export views on sheets and links as external
references is cleared.

File name/prefix: | DraftingView-STARTINGVIEW

10.

| Filesof type: | AutoCAD 2018 DWG Fies (*.dwg)

Maming: |Automatic - Short

l [ClExport views on sheets and links as external references l

oK Cancel
11. Click OK

DND BIM Template and Content User Guide Page 10



4.2  Placing Generic Annotations & Tags

4.2.1 Using Generic Annotations

In the Annotate tab, use the Symbol command to place a Generic Annotation in any view.

-

Symbol

Symbol

4.2.2 Tagging Families

1. First load tags into project as Families. These can be loaded into projects by:
= Copying and pasting from Revit Family Container using the Clipboard.
= Clicking and dragging from the provided content folders in File Explorer.
= Using the Load Family button on the Insert Tab, open from the provided content folder.

2. On the Annotate tab, select the Tag by Category command.

.I.‘Irg Multi- Category
.I,‘r‘é Material Tag

.!@ﬁ' Loaded Tags And Symbols

Tag

3. (Recommendation) Use the Loaded Tags and Symbols command to set the tags prior to tagging.
Alternatively, the tag type can be changed in properties menu.

S ro

TIP: Tags can be used for 3D models if they still are hidden in view, use the course medium fine
parameters to adjust visibility graphics. This way the tag, which is the symbol, is seen and the 3D model
is not.
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4.3 Creating Sheets with the Titleblock

A Titleblock and Cover Sheet ISO B1 are provided in the template and container files. Both have shared
parameters incorporated into the sheets and are pre-mapped in both the template and container.
Parameters can be modified by either selecting the field directly on the sheet or inputting the data into
the appropriate field in the properties window. A combination of shared parameters and project
information parameters are used as shown below:

Properties Menu: st‘m'mze’aocx : | F3 Edit Type

~

Current Revision Date

Current Revision Description

=

'J:ppmvsd By

Designed By

Ty
e

Sheet Number

Sheet Name ITITLEBLOCK

Sheet lssue Date :10/09/20

Appears In Sheet List =]
N Revisions on Sheet | %t s
We(t

DND_Trade | Métier

( DND_Level of Security | Niveau de Sécurité
DND_Reviewed | Revu || Title 4 Name/Initials .
DND_Reviewed | Revu || Tiled )
'DND_Reviewed | Revu || Title 2 Name/initials
DND_Reviewed | Revu || Title 3
DND_Reviewed | Revu || Title 2 Name/Initials
DND_Reviewed | Revu || Title 2
DND_Reviewed | Revu || Title 1
DND_Reviewed | Revu || Title 1 Name/Initials

1—[ System Parameters Used ]

Shared Parameters Created ]

DND_Reviewed | Revu || Des O | Agent Conc
DND_Reviewed | Revu || Des Mgr | Gést Conc
DND_Reviewed | Revu || Fire | incendie
DND_Production | Coardination

DND_Sheet Total | Total des Plans

\ 'DND_Subject | Sujet T Sample Subject.. T
EUND_R:\J\WEH]RWU\]FI\: Mgr | Gést Proj I 1
File Path :C:\Users\macdonan\Documents\CAD ..
Guide Grid <None>
v
Properties help Apply
Project Info Menu:
n
Family: System Family: Project Information v Load..
Type: ~ Edit Type...
Instance Parameters - Control selected or to-be-created instance
Parameter ‘ Value |
|Identity Data K
Organization Name { |
Organization Description
Akt Stacture ms oo aanctate Avaie Mosingtsae  Cototorate View | ntansge | Building Name
= o Al
@ Bn G 2 @ % 0O F s uther : i :
T S SIS TSRO 2
Setings [Sacigutatting (73
Title Text
DND_Project | Projet Sample Project Title
DND_WBS Number | No. SRT WBS # (Project Info)
DND_PF Number | No. DP PF # (Project Info) - -
DND_DWG. NO. | NO. Dessin DWG NO (Project info) Project Information Parameters Used ]
DND_Lecation | Emplacement Sample Location
Project Issue Date Issue Date
Project Status Project Status
Client Name Owner
Project Address Enter address here
Project Name Project Name
Project Number 0001
OK Cancel
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